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Revision History 
Version Revision Date Description 

10-3-2006 Functions added/changed 
• Added support for Maya 8.0. 

Bug fixes 
• Fixed the problem of unnecessary output option configuration nodes sometimes 

accumulating in the scene. 

4-17-2006 Bug fixes 
• Fixed the problem with the incorrect display of normal lines when a non-uniform scale 

value (X, Y, Z values are not the same) is configured in the node. 

• Fixed the problem of option settings no longer being able to save to scene once a scene 
with a saved setting of the output plug-in is imported. 

11-28-2005 Bug fixes 

• Corrected the imd file's <box test> to output correctly. 

9-12-2005 Functions added/changed 
• Added support for Maya 7.0. 

• Added a caution to “2.7.3 Vertex Color” regarding Maya 7.0 . 

6-20-2005 Bug fixes 
• Revised the software so that it outputs material color animations and texture SRT 

animations that use character sets. 

• Fixed problem with color becoming dark in some places when 4x4 texel-compressed 
textures were created from texture files with names ending in cmp4 and without 
additional information. (The palette data may be larger than in the previous version in 
some cases.) 

3-24-2005 Bug fixes 
• Scene containing reference file was not saved correctly because of influence from output 

plug-in. This problem was fixed. 

2-28-2005 Functions added/changed 
• Added support for Maya 6.5. 

1.6.0 

2-2-2005 Functions added/changed 
• Added support for the Intermediate File Format Version 1.6.0. 
• Updated the following data creation plug-ins: 

• NITRO Set Material Attribute (p. 38, p. 57). Added the Texture Effect Matrix. Deleted 
the Tex Gen ST. 

1.5.0 1-14-2005 Functions added/changed  
• Added the batch export feature of intermediate files. 
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Version Revision Date Description 

12-13-2004 Functions added/changed 
• Added support for Intermediate File Format Version 1.5.0. 

• Added warning (p. 34). 
• Updated the following data creation plug-in: 

• NITRO Set Material Attribute (p. 38) 
Added attribute that can be set. 

• Added the following data creation plug-ins: 
• NITRO Set Render Priority (p. 44) 

• NITRO Show Render Priority (p. 45) 

Revisions only in the manual 
• Added "2.7.9 Polygon Rendering Priority (p. 14). 

• Revised the description of "3.2.2 General Options" Unite and Combine Polygon (p. 26). 
• Revised the description of "3.2.5 Animation Options" Interpolation (p. 30). 

10-25-2004 Functions added/changed 
• Updated the following data creation plug-ins: 

• NITRO Set Material Attribute (p. 38). 
Added attribute that can be set. 
Changed the name Lighting to Light0. 

• NITRO Show Lighting (p. 42) 
Made changes to check four lights separately. 

Revisions only in the manual 
• Revised the description of “2.7.3 Vertex Color.” (p. 13) 

• Revised the description of the intermediate file output plug-in option Interpolation. (p. 25) 

1.4.2 

8-30-2004 • In the imd file, the scale_compensate attribute of <node> is now exported only when the 
scaling_rule attribute of <model_info> is maya.  

• Corrected the bug that prevented the texture that is connected to the top layer of a 
layered texture from being exported. 

• In NITRO, when an attempt is made to rename over 16 Characters, a warning is now 
generated when a texture file cannot be opened. 

• Added support for Maya 6.0.1. 

• Added a note to the manual to note that the differences in the imd file vertex data 
depends on the Maya version. 

• Added a note to the manual regarding texture pattern animation in Maya 6.0.1.  
• Added an explanation to the manual regarding envelopes in NINTENDO NITRO-System.

1.4.1 7-26-2004 • Added a warning when a name for export to an intermediate file exceeds 16 characters. 
(Ch 3.6) 

• Added “element name character string replace (NITRO-Replace Character)” and 
“rename element names that exceed 16 characters (NITRO Rename Over 16 
Characters)” to the data creation plug-in (Table 4.1, Ch 4.9, 4.10) 

• Added warnings about the unit to be used for vertex coordinates and Translate values. 
(Ch 2.2) 

1.4.0 6/30/2004 • Changed the naming convention for <polygon> element in the imd file to “polygon + 
serial number”.  

• Several errors and warnings for intermediate file output were added. (pp. 25-26) 



NITRO Intermediate File Plug-in for Maya 

NTR-06-0008-001-B 8  2004-2006 Nintendo 
Released: October 12, 2006  CONFIDENTIAL 

Version Revision Date Description 

1.3.0 5/24/2004 • Added support for TGA and PIC files that contain additional Nintendo NITRO-System 
information (paragraph 2.11.2). 

• Added functionality to input and output the option settings for intermediate file output 
plug-ins as n3es files (paragraph 3.1). 

• Added scaling rule to ica file <node_anm_info>.

1.2.1 4/20/2004 • Corrected the version of the intermediate file that can be output from version 1.1.0 to 
version 1.2.0 in 1 Intermediate File Types (p. 7). 

1.2.0 4/12/2004 • Changed to allow output of intermediate files from NITRO Export in the Nintendo NITRO-
System menu. 

• Added functionality to transfer data to the 3D Material Editor. 

• Added functionality to store intermediate file output plug-in option settings in a scene. 

• In imd file, changed <material> polygon mode from “toon hilight” to “toon highlight”. 

1.1.1 3/25/2004 • Made corrections to indicate that <polygon> with vertex color does not combine with 
<polygon> without vertex color when Compress Node is Unite and Combine 
Polygon or Compress Material is Compress.

• Made corrections so that the Merge Useless Node process is the same as the manual 
algorithm. (In the previous version, when the root node for the exported imd file was 
world_root, there were occasions when it changed to another node. Because the total 
number of nodes and the layer structure did not change, there is no need to re-export the 
ica and iva files.) 

• Made corrections so that pos_scale in <box_test> is not larger than necessary. 

1.1.0 3/1/2004 • Added Use Primitive Strip to the Imd Options output options. 

• Added support for the A3I5 translucent texture. 
• Made a correction so that for textures other than translucent textures, if the alpha of the 

texture file is 128 or larger the texel is considered to be opaque. 

• Made a correction so that in the color index format, targa files with alphas are processed 
correctly. 

• The volume_min, volume_max, and volume_r attribute values included in the <node> 
element were being unnecessarily multiplied with (2 to the power of pos_scale). This 
has been corrected. 

• In the manual, the limits on the names that the Nintendo NITRO-System uses (node 
names, material names, texture names, and palette names) have been changed from a 
maximum of 15 characters to a maximum of 16 characters. 

• Added the section 2.12.5 Shapes Output by the imd File. 
• Changed the code in section 5.3 Maya Texture Matrix (m[15] only). 

1.0.2 2/12/2004 • Made a change to stop the division into triangular polygons and output of quadrilateral 
polygons and concave quadrilateral polygons for which all vertices are not on the same plane. 
In Maya, all quadrilateral polygons will now be output as quadrilateral polygons. If this does 
not display properly on the production device, divide into appropriate polygons in Maya. 

• Support for changing the number of faces after skinning. Division into triangles is now 
possible after skinning. However, as before the number of vertices cannot be changed. 

• Changed so that if the 4 x 4 texel compressed texture palette exceeds 32786 colors, the 
image quality drops and the palette is compressed to less than 32786 colors. 

1.0.1 2/2/2004 • Changed the valid digits of the Magnify and Tolerance output options to the 4th decimal place.

• Fixed a bug where Maya would crash if, when the Texture SRT Animation is set, another 
animation file is output without outputting the ita. 

1.0.0 1/23/2004 Initial version. 
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1 Intermediate File Types 
The following table shows the different types of intermediate files that can be output from this plug-in. 

Table 1-1  Types of Intermediate Files 

Extension Type of data Description 

imd Model data Model information, including vertex, polygon, hierarchy, material 
and texture data 

ica Character animation data Animation information for controlling node matrices 

iva Visibility animation data Animation information for controlling node visibility (show / hide) 

ima Material color animation data Animation information for controlling material color 

itp Texture pattern animation data Animation information for substituting numerous textures 

ita Texture SRT animation data Animation information for controlling texture matrices 

The version of the intermediate file output from this plug-in is 1.5.0. 
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2 Precautions Regarding Creation Data for NITRO 

2.1 Maya Version 
This plug-in is for Windows Maya 5.0.1, 6.0.1, 6.5, 7.0, and 8.0. Operation is not guaranteed for any other 
version of Maya. 

2.2 Preference Settings 
We recommend that in “Settings” you set “Linear” to centimeter.

Vertex coordinates and Translate values are always output to intermediate files and automatically 
converted to centimeters. 

Notice that, if you use something other than centimeters, the coordinate values and the Translate 
values in Maya will differ from those in the intermediate files. 

In “Settings”, Angular should be set to degree. 

2.3 Nodes 

2.3.1 Root Node 

Intermediate files always have a single root node. 

If a number of root nodes have been created in Maya, the plug-in groups all of them together into a 
single node called world_root and adds this to the Intermediate file that gets exported. 

2.3.2 Nodes Not Exported 

• Transform nodes and joint nodes are not exported when the Template attribute is set to 
ON and the Display Layer makes them invisible. (The exception is for influence objects.) 

• When a node is not exported, none of its child nodes are exported either. 
• Transform nodes that do not possess child nodes (locator, empty group, etc.) are not 

exported. 
• When the mesh node's Template attribute or Intermediate Object attribute is set to ON, 

the parent transform node is exported as a node without a mesh node (polygon data is 
not exported). 

• Nodes are not exported if the Shading attribute of their Display Layer is OFF (always 
wireframe display). 

Note: Nodes are always exported, regardless of the above conditions, if the node-culling disable flag 
is set by the NITRO Set No Cut Node plug-in. 
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2.3.3 Culling Nodes Not Needed for Model Display 

In addition to the previously mentioned nodes that are not exported, you can specify to cull and not 
export nodes that are not required for model display. This is done using the Intermediate File Plug-in 
option “Compress Node” and selecting “Cull Useless Node” or “Merge Useless Node”. 

Also, in situations where node hierarchy is not necessary such as for topographic data, you can select 
“Unite” or “Unite and Combine Polygon” in this Compress Node option to merge multiple nodes into a 
single node for export. 

2.3.4 Node Names 

Note: If you are using the Nintendo NITRO-System library, node names should be no longer than 16 
characters. 

You need to be careful with node names because Maya will accept nodes with the same name as long 
as they have different parent nodes. If multiple nodes with the same name exist, the node that is 
shallowest in the hierarchy will be exported with its original name, and all other nodes will be exported 
with node names appended with a suffix comprising the underscore and a number (_1, _2, etc.). If you 
are using the Nintendo NITRO-System library, be aware that the node name must be no longer than 16 
characters including this suffix. 

If multiple nodes with the same name exist at the same depth in the hierarchy, then the node that gets 
exported with its original name will be the node that is displayed at the top when Sort Order is set to 
Scene Hierarchy in the Outliner. 

2.4 Animation 

2.4.1 Time Axis 

All of the Intermediate file's animation data are exported in values of integer frames. 

Be aware that when a stepped tangent is specified for a key at a frame fraction, the timing may deviate 
from that in Maya during slow play on NITRO. 

2.4.2 Values Exported to the imd File 

When an attribute is animated, the value that is exported to the imd file is the Start frame as specified 
in the Export Options. For the Translate, Rotate and Scale attributes of nodes that are affected by 
skinning, the value that is exported is the state of the bind pose. 

Be aware that the value that is exported is not the value for the current frame in Maya.  
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2.5 Transform Node 
The following attributes of the transform node can be animated: Translate, Rotate, Scale, and Visibility. 

Attributes that require special care are explained below: 

• Pivot 

We recommend that you set Rotate Pivot and Scale Pivot the to the same value. If they are 
different, the volume of animation data could increase. 

When data is exported, Rotate Pivot is treated as the origin in local coordinate space. 

If Pivot is not the same in every frame, data cannot be output correctly. Do not animate Pivot. 

• Shear 

Set Shear all to 0. Otherwise, data cannot be output correctly. 

• Rotate Order 

We recommend the Rotate Order be set to xyz. If it is set to anything else, the volume of 
animation data could increase. 

• Rotate Axis 

We recommend setting Rotate Axis all to 0. Otherwise, the volume of animation data could 
increase. 

• Inherits Transform 

Set Inherits Transform to ON. If it is set to OFF, data cannot be output correctly. 

• Visibility 
If the transform node visibility is set to OFF, all levels of nodes below that will not be 
displayed. If you want to display the polygon models of only specific levels, set the mesh 
node visibility to off. 

2.6 Joint Node 
The following attributes of the joint node can be animated: Translate, Rotate, Scale, and Visibility. 

Attributes that require special care are explained below: 

• Rotate Order 

We recommend the Rotate Order be set to xyz. If it is set to anything else, the volume of 
animation data could increase 

• Rotate Axis 

We recommend setting Rotate Axis all to 0. Otherwise, the volume of animation data could increase. 

• Inherits Transform 

Set Inherits Transform to ON. If it is set to OFF, data cannot be output correctly. 
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• Joint Orient 

We recommend setting Joint Orient all to 0. Otherwise, the volume of animation data could increase. 

• Segment Scale Compensate 

Do not change the Segment Scale Compensate value when exporting imd files and ica files. 

2.7 Polygon Models 

2.7.1 Polygon Shapes 

NITRO cannot display certain polygon shapes correctly. These are listed below. In Maya, first divide 
these shapes into triangles and then export. 

• Polygons whose vertices do not all lie in the same plane. 
• Concave polygons with internal angles of 180 degrees or larger. 
• Polygons with openings. 

As a result of deformations from skinning, polygons with these shapes must also be divided into 
triangles before output. In Maya, quadrilateral polygons can all be output as quadrilateral polygons. For 
all polygons with five or more sides, divide into triangles before outputting. 

Note: In developing the plug-ins for Maya 5.0.1, Maya 6.0.1, or later, different environments were 
used. Thus, the order of vertices in the <polygon> element and the number of vertices that 
are processed when linked polygons are used differ in the imd files that are created by these 
versions of Maya. 

2.7.2 Setting the Display Face 

The display face (front face, back face, or both faces) is set as a shading group attached to the 
polygons. To set the display face, select either a shading group (shadingEngine node) or a material 
node (Lambert node, etc.) and then execute the NITRO Set Material Attribute plug-in. Note that the 
process is not reflected on Maya. 

To check the display face, use the NITRO Show Display Face plug-in. 

The mesh node's Backface Culling attribute and “Shading” > “Back Face Culling” are only set for 
display on Maya and are not reflected in the Intermediate file. 

2.7.3 Vertex Color 

If you have created a model for which vertex color has been specified and you want to display the 
model without doing a light calculation, use the NITRO Set Material Attribute plug-in to turn OFF all of 
the lights that affect the shading group attached to the polygons. (Light 0 is ON by default.) 

When the light that is affected is set to ON by the NITRO Set Material Attribute plug-in, the model can 
be displayed using a combination of vertex color and light calculations. (However, it remains undecided 
whether the Nintendo NITRO-System library will support this feature.) 
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When multiple color sets are set with Maya 7.0 or later, the colors of the current color set are output. 

2.7.4 Instances 

Even if you use instancing, if there are multiple objects with the same shape, they are all exported in 
the same way. 

2.7.5 Limitations of Combine 

If Combine is applied to a skinned object when history is enabled, the skinning animation will display 
on Maya but it will not be output on NITRO. As a rule, you should delete history after applying Combine. 

2.7.6 Vertex Translate Animation Prohibited 

Vertex translate animations cannot be exported. 

2.7.7 Proxy Shapes 

Deform animations (skinning, etc.) that use proxy shapes created with Smooth Proxy cannot be 
exported. However, the shapes can be exported if they are not animated. 

2.7.8 Number of Valid mesh Nodes 

Under each transform node there should be only one valid mesh node that has its Intermediate Object 
attribute set to OFF. Normally there is only one valid mesh node, but a number of them exist when 
“Deform” > “Display Intermediate Objects” has been executed for a model with skinning configured. 

2.7.9 Polygon Rendering Priority 

When multiple materials are associated with a single mesh model (equivalent to the <node> element in 
the imd file) in a 3DCG tool, the multiple polygons that constitute the mesh model are divided into multiple 
polygon groups (equivalent to the <polygon> element in the imd file). In such a case, you can control 
the order in which polygon groups are rendered with respect to each material in the 3DCG tool by setting 
the rendering priority (equivalent to the priority attribute of the <display> element in the imd file). 
Rendering priority is used when transparent polygons are displayed overlapping each other or when 
decal polygons are displayed. 

Note: The rendering order mentioned here is the order in which render commands are sent to the 
NITRO geometry engine. According to the NITRO hardware specification, translucent polygons 
are always rendered after opaque polygons. Therefore, even if you set priority so that 
translucent polygons are rendered before opaque polygons, rendering in NITRO will always 
start from opaque polygons. 

If you want to manage rendering order for a polygon group, order it by setting a rendering priority of at 
least 1 (the lower the value the earlier it is rendered). 
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If there is no need to specify rendering order for a polygon group, set the rendering priority to Don't 
care. The rendering routine will determine the rendering timing for polygon groups that have a 
rendering priority of Don’t care. If there are multiple polygon groups with the same rendering priority, 
the rendering routine will determine which polygon group to render from. 
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Since the rendering priority for polygon groups a and d is Don't care, the rendering routine will 
determine when to render each. 

Note: The rendering routine in the G3D library that is supplied with the NINTENDO NITRO-System 
controls rendering order using the latter: overall model rendering order. 

The NITRO Set Render Priority plug-in is used to set rendering priority. If you do not set rendering 
priorities for materials with the NITRO Set Render Priority plug-in, the materials will be handled as 
render priority=Don't care. Use the NITRO Show Render Priority plug-in to check the priorities that 
have been set. 

• The material compression feature and polygon groups 
If two different materials within the same node have the same content and the same rendering priority, 
when you use the material compression feature in the intermediate file export plug-in, the materials 
and the polygon groups will each be combined into one. 

If two materials are the same but their rendering priorities are different, the materials will be combined 
into one, but the polygon groups will not because their rendering priorities are different. 

If different nodes contain the same materials and the same rendering priorities, the polygon group will 
be combined into one, only if Unite and Combine Polygon is specified when culling nodes. 

2.8 NURBS Models 
NURBS surfaces and NURBS curves cannot be exported. NURBS surfaces should be converted into 
polygons for export using the NURBS to Polygons operation.  

When you convert an animated NURBS model into polygons, the polygon model will also be animated 
on Maya, but on NITRO it will be fixed in the state of the Start frame. You need to first delete the 
polygon model's history and then configure animation for it. 

2.9 Subdivision Surfaces 
Subdivision surfaces cannot be exported. Subdivision surfaces should be converted into polygons for 
export using the Subdiv to Polygons operation. 
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2.10 Materials 

2.10.1 Material Types and Attributes 

Use a Lambert shader if you are not using Specular. Otherwise, use a Blinn, Phong, or Phong E shader. 
All three of these shaders output data the same way. 

These attributes get reflected in the Intermediate file that is exported: 

• Color → diffuse 
• Transparency (R value) → alpha 
• Ambient Color → ambient 
• Incandescence → emission 
• Diffuse → Scale multiplied by diffuse 
• Specular Color → specular 

You can configure attributes for NITRO using the NITRO Set Material Attribute plug-in. 

When a file node is attached to the Color attribute, the file node's Color Gain attribute gets reflected in 
diffuse but the file node's Color Offset attribute does not. When a layeredTexture node is attached to 
the Color attribute, it is the Color Gain attribute of the file node attached to the top layer that gets 
reflected in diffuse.

Concerning the transparency attribute, of the RGB values, only the R value is reflected in alpha in the 
intermediate file. The G and B values are ignored. 

When a file node is attached to the Transparency attribute, the file node's Alpha Gain attribute gets 
reflected in alpha but the file node's Alpha Offset attribute does not. 

NITRO displays the wireframe when the alpha value is 0. However, in NINTENDO NITRO-System, 
when alpha is 0, no render command is sent for the polygon to which the material is allocated, and 
thus it is not displayed. You can set wireframe display with the NITRO Set Material Attribute plug-in. 

2.10.2 Material Names 

If you are using the Nintendo NITRO-System library, material names should be no longer than 16 
characters. 

One material name is output to intermediate files for each shading group. 

If one material name is linked to multiple shading groups, the name used by the first exported node will 
be exported, name unchanged. However, other materials will be exported with underscore number 
combinations (such as "_1", "_2") appended after the material name. 

When using the Nintendo NITRO-System Library, make sure that material names, including the 
underscore and number, does not exceed 16 characters. 
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2.10.3 Material Color Animation 

Animation can be set for the following attributes: Color, Transparency (R value), Ambient Color, 
Incandescence, and Specular Color. Do not set animation for Diffuse. 

When a file node is attached to the Color attribute, the animation set in the file node's Color Gain 
attribute gets reflected in diffuse.

Concerning the transparency attribute, of the RGB values, only the animation that is set in the R value 
is reflected in the intermediate file. Animation set in the G and B values is ignored. 

When a file node is attached to the Transparency attribute, the animation set in the file node's Alpha 
Gain attribute gets reflected in alpha.

2.11 Textures 

2.11.1 Texture Nodes 

Only file nodes can be used as textures. Procedural textures like checker and ramp cannot be 
exported. Use the Convert to File Texture to convert them to file node export them. Connect the file 
node to the material's color attribute. When a Layered Texture is used, only the texture of the file node 
that is attached to the top layer gets exported. 

PSD File textures (psdFileTex nodes) that were added in Maya 6.0 cannot be exported. 

2.11.2 Texture Files and Format 

When you use TGA or PIC files that contain additional Nintendo NITRO-System information (called 
additional information below), the texture format, palette name, texel data, palette data and the like that 
are recorded in the additional information are reflected in the intermediate files. 

Currently you can make TGA and PIC files that contain additional information with the Nintendo 
NITRO-System Photoshop plug-ins. For information on using Nintendo NITRO-System Photoshop 
plug-ins, see the “Nintendo NITRO-System Photoshop Plug-in Manual.” 

You can also use all texture file types supported by file nodes in files other than TGA (PIC) files that have 
additional information. However, in that case multiple textures will not be able to share palette data. 

When a texture is exported, it is output using the same file name without the extension. Do not use 
double-byte characters or katakana characters in file names. 

The maximum height and width for texture images is 1024 texels. If the height or the width is not of a 
size used by NITRO (8, 16, 32, 64, 128, 256, 512, 1024), then texel color is added to the right side or 
the bottom side in order to export the texture image in a size that is used by NITRO. 

In the case of TGA and PIC files that have additional information, the texture format will be the one that 
is specified in the additional information. 

In the case of texture files that do not contain additional information, the texture format is determined 
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automatically based on the following rules. For textures other than translucent textures, alpha values 
(8-bit) of 128 or greater are considered to be opaque. 

 (1) When file name without extension ends in _cmp2 

→ 4x4 texel compressed texture (use linear interpolation with maximum 2 palettes for every 4x4 
texels)  

 (2) When file name without extension ends in _cmp4 

→ 4x4 texel compressed texture (maximum 4 palettes for every 4x4 texels) 

 (3) When neither of above, translucent texels and 8 or fewer colors are being used 

 → A5I3 translucent texture 

 (4) When none of above, translucent texels and 32 or fewer colors are being used 

→ A3I5 translucent texture 
 (5) When none of the above, the format is determined based on the number of colors being used 

• Number of colors is 2 or less → 2-color palette texture 
• Number of colors is 4 or less → 4-color palette texture 
• Number of colors is 16 or less → 16-color palette texture 
• Number of colors is 256 or less → 256-color palette texture 
• Number of colors is 257 or more → Direct color texture 

With the exception of the direct color texture format, palette data is also exported.  

In the case of TGA and PIC files that have additional information, the palette name will be the one that 
is specified in the additional information. If the palette name that is specified in the additional 
information is blank, _pl will be appended to the end of the file name (the extension remains 
unchanged). 

In the case of texture files that do not have additional information, _pl will be appended to the end of 
the file name (the extension remains unchanged). If you want multiple textures to share palette data, 
when you make TGA or PIC files that have additional information, specify the same palette name. 
However, notice that if you give the same palette name to palettes that have different palette data, an 
error will occur when you output intermediate files.. 

Note: If you are using the Nintendo NITRO-System library, texture names (excluding the extension) 
and palette names should be no larger than 16 characters in size. 

2.11.3 Texture Attributes 

The following place2dTexture node attributes get reflected in the Intermediate file: Translate Frame, 
Rotate Frame, Mirror U, Mirror V, Wrap U, Wrap V, and Repeat UV. 

You should set the place2dTexture node's Coverage attribute to (1, 1), the Offset attribute to (0, 0) and 
the Rotate UV to (0). 

When the Wrap U attribute or the Mirror U attribute is set to ON, texture images will not display 
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properly if the image width is not equal to 8 or a greater power of 2. Similarly, when the Wrap V 
attribute or the Mirror V attribute is set to ON, texture images will not display properly if the image 
height is not equal to 8 or a greater power of 2. 

The NITRO texture matrix becomes an identity matrix (without texture SRT) under this specific set of 
conditions: the Translate Frame attribute is (0,0), the Rotate Frame attribute is (0) and the Repeat UV 
attribute is (1,1). When the texture matrix is not an identity matrix, it will output as TexCoord even if Tex 
Gen Mode has been set to NONE by the NITRO Set Material Attribute plug-in. 

2.12 UV Limitations 
In Maya, textures are not displayed on surfaces without UV, but NITRO does not have this feature. Set 
the UV for all polygons to which textures are pasted. 

The sizes of UV values must fulfill the following conditions: 

–2048 <= U Value x Texture Width < 2048 

–2048 <= V Value x Texture Height < 2048 

When there are no default Translate Frame, Rotate Frame, or Repeat UV values, the result UV values 
applied to their attributes must fulfill the conditions indicated above. Be careful that Repeat UV, etc., do 
not become too large. 

2.12.1 Texture Pattern Animation 

For texture pattern animation, set the file node's Use Frame Extension attribute to ON and set keys for 
the Frame Extension attribute. There is no support for driven keys and expressions. 

Note: With the Attribute Editor of Maya 6.0.1 or later versions, the Use Frame Extension attribute is 
displayed as “Use Image Sequence” and the Frame Extension attribute is displayed as “Image 
Number.” When the “Use Image Sequence” (Use Frame Extension) attribute is set to ON, an 
expression is automatically connected to the “Image Number” (Frame Extension) attribute. 
Accordingly, press the key after deleting the expression. Set the Frame Offset attribute to 0. 

The texture files are prepared with names that have a numeral in front of the extension corresponding 
to the Frame Extension (name.1.tga, name.2.tga, name.3.tga...). Make the width and height of 
each texture file the same. 

Note: By default, the only textures exported in the imd file are textures specified with a file node 
Image Name attribute and textures that correspond to keyed Frame Extension attributes. 

For example, consider a texture with the Image Name name.1.tga. If this texture has only two set 
keys, one at the Start frame with Frame Extension = 1 and one at the End frame with Frame Extension 
= 4, then only two texture files are exported to the imd file: name.1.tga and name.4.tga. The files 
name.2.tga and name.3.tga are not exported even if linear tangents are specified for the animation 
curve. If no texture corresponding to the animation curve's Frame Extension is exported, the texture 
that most closely corresponds to the Frame Extension is used as the pattern animation data. 
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Note: You can forcibly export textures to the imd file by specifying them using the NITRO Set Frame 
Extension List plug-in. 

Thus, for example, if you set the Frame Extension range to "1-4" (1 through 4) for forced export, then 
all four can be exported with linear tangents specified for the animation curve, even though only two 
keys are set: one at the Start frame with Frame Extension = 1 and one at the End frame with Frame 
Extension = 4. 

If multiple itp files are being used with a single imd file, you must use this NITRO Set Frame Extension 
List plug-in to make the necessary setting so all required textures are exported in the imd file. 

2.12.2 Texture SRT Animation 

For texture SRT animation, the following attributes of the place2dTexture node are animated: Repeat 
UV, Rotate Frame, and Translate Frame. 

2.13 Skinning 

2.13.1 Skinning Settings 

Smooth skinning is supported. Rigid skinning is not supported. 

Smooth skinning is set with: “Skin” > “Bind Skin” > “Smooth Bind” 

Note: Do not perform these kinds of operations after “Bind Skin”: 

• Operations that change the number of vertices 
• Deleting a joint node that affects skinning 
• Changing Rotate Order or Segment Scale Compensate of a joint node that affects skinning 

If you want to perform any of the above operations, first use “Detach Skin”. 

You can change the location of a vertex even after “Bind Skin”. However, the tweak node must be 
upstream from the skinCluster node. (The tweak node is usually created upstream from the skinCluster 
node, but in the window that opens from Inputs > All Inputs on the popup menu, the tweak node may 
be downstream from the skinCluster node in some situations, like when the order of the Deformers has 
changed.) 

If skinning has been specified, the imd file's translate, rotate, and scale are exported in the bind 
pose state. 

If you specify skinning for a model that has a parent node, do not change the parent node's Translate, 
Rotate and Scale values after “Bind Skin”. If you want to translate the entire model, do so by translating 
the highest-order skeleton. 

Do not change the name of an original mesh node (~Orig) that has been created after “Bind Skin”. 

The total skinning weight on a single vertex should be 1.0. 
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2.13.2 Delete Skinning 

The “Detach Skin” History option usually should be set to Delete History. If you set the option to Keep 
History you can maintain weight values, but you will only disable the skinCluster node, not detach it 
completely. 

Note: If you Detach with the option set to Keep History, do not perform any operations afterward that 
change the number of vertices or delete a joint node that affects skinning. 

Certain operations can be performed even after the option is set to Keep History. These include 
changing the bind pose and adding skeletons. 

2.13.3 Influence Objects 

Influence objects are exported as transform nodes. (Polygons are not output.) 

The Add Influence option Use Geometry should be set to OFF. 

2.13.4 Skinning and Projection Mapping 

If you are going to perform projection mapping (Planar Mapping, Cylindrical Mapping, Spherical 
Mapping, Automatic Mapping) after Bind Skin, you should set the projecting mapping option Insert 
Before Deformers to ON. 

2.13.5 Polygon Shapes Output to the imd File 

When setting up skinning, the polygons for the bind pose shape are output to the imd file. 

However, when using the Unite Compress Node or the Unite and Combine options of the Intermediate 
File Output Plug-in, the shape of the polygon in the start frame is output. If these functions are used, 
the same shapes as in Maya can be used with the standalone imd file. (Since there will be one node, 
character animation and visibility animation is not possible). 

2.13.6 Envelopes in NINTENDO NITRO-System 

The deformation process that is called “skinning” in Maya is called “envelope” in the NINTENDO 
NITRO-System. 

In the NINTENDO NITRO-System, there are two types of envelopes: fully-weighted envelopes and 
weighted envelopes. 

• Fully-weighted envelopes  
A fully-weighted envelope is an envelope in which each vertex is fully weighted toward a single 
node. If all the vertices in a polygon mesh use fully-weighted envelopes, the model is called a 
fully-weighted envelope model. 
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Figure 2-2  Example of a Fully-Weighted Envelope Model 

• Weighted envelope  
A weighted envelope is an envelope in which each vertex is associated with two or more nodes 
and the total weighting toward these nodes is 100%. If at least one vertex of a polygon mesh is a 
weighted envelope vertex, then the model is called a weighted envelope model. 

A weighted envelope model allows you to create smooth curved surfaces by, for example, increasing 
the number of nodes that are associated with each vertex or increasing the variety of weighting values. 
However, this increase will result in a greater amount of calculation during rendering. 

Figure 2-3  Example of a Weighted Envelope Model 

Note: For information on support for weighted envelope models in the G3D library provided by the 
NINTENDO NITRO-System, see the G3D Library Release Notes. 

2.14 Visibility Animation 
There are two ways to configure visibility animation: by animating the Visibility attribute of the transform 
node, and by animating the Visibility attribute of the mesh node. 

• When the transform node's Visibility attribute is animated, the Visibility ON/OFF state 
affects all nodes lower in the hierarchy. 

• When the mesh node's Visibility attribute is animated, the Visibility ON/OFF state only 
affects polygons in the same level of the hierarchy. In order to set keys for the mesh 
node's Visibility attribute, select mesh node, open “Window” > “General Editors” > 
“Channel Control” and then set visibility to Keyable. 
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The visibility animation settings are configured in regard to nodes, so if you have set the Compress 
Node intermediate file export plug-in option to either “Cull Useless Node” or “Merge Useless Node” be 
sure that you do not end up deleting nodes for which visibility animation has been set. (You can use 
the NITRO Set No Cut Node plug-in to prevent deletion of specified nodes.) When exporting visibility 
animation, do not set Compress Node to either “Unite” or “Unite and Combine Polygon”. 

2.15 Billboard 
Billboard is set in regards to the transform node using the NITRO Set Billboard plug-in. However, this is 
not reflected on the Maya screen. You can check the billboard using the NITRO Show Billboard plug-in. 
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3 Intermediate File Export Plug-In 

3.1 How to Use 
To only export specified nodes (including nodes at lower hierarchical levels), select the node that you 
want to output. If you are exporting the entire scene you do not need to select nodes. 

Click “Nintendo NITRO-System” > “NITRO Export” to display the “NITRO Export Option” window. 

To output an intermediate file, set the appropriate options and then click either “Export” or “Apply.” 
Unlike “Export,” “Apply” does not close the option window after output. The option settings at the time 
of output will be recorded in Maya as the current options. You can also save the option settings in a 
scene, or input and output them as an n3es (NITRO 3D Export Settings) file. For details see “3.3 
Managing Option Settings.” 

Click “Nintendo NITRO-System” > “NITRO Export” if you want to output with current options without 
displaying the option window. 

3.2 Options 

3.2.1 Output Options 

These options relate to methods of outputting intermediate files. 

Figure 3-1  Output Options 

• Export 

To output the entire scene specify “All”. To only output the selected node and those below it, 
specify “Selection.” 

An exception is when you select a model that is set for skinning and specify “Selection.” In that 
case, nodes that are influenced by the skinning, and nodes at a hierarchical level higher than the 
model that is set for skinning, will also be output. 
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• Output File Name 

This sets the intermediated file name (but not the extension). Do not use full-width or half-width 
kana characters. 

If you click the “Scene” button that is on the right, the current scene name will be set. If you click 
the “Node” button, the selected node name (the node at the highest hierarchical level) will be set. 
If you click the “Node” button without selecting a node, the name of the first node (in alphabetical 
order) will be set. 

• Output Intermediate Files 

Select this if you want to output intermediate files to a specified folder. 

In “Output Folder” specify the folder to which you want to output intermediate files. Do not use 
full or half width kana characters. 

• Use 3D Material Editor 

Select this to transfer intermediate file data to the 3D Material Editor. You cannot select both 
Output Intermediate Files and Use 3D Material Editor at the same time. 

If you turn “Merge Imd File” ON, and specify the imd file path name, after the data has been 
transferred, the 3D Material Editor will automatically merge-load the specified imd file. Do not 
use full or half width kana characters in the imd file path name. 

For information on using the 3D Material Editor, read the Nintendo NITRO-System 3D Material 
Editor manual. 

3.2.2 General Options 

The following general options apply to all Intermediate files: 

Figure 3-2  General Options 

• Magnify 

The power to which to multiply the model's vertex coordinates and Translate value. 
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• Compress Node 

This specifies the node-culling mode. By reducing the number of nodes you ease the processing 
load for matrix calculations and use less memory. 

The culling involves the nodes exported to the Intermediate file and does not change the data on 
Maya. 

Table 3-1  Node Culling Modes 

Mode Explanation 

None Nodes are not culled. 

The hierarchical structure created on Maya is exported as-is. 

Cull Useless Node Data are output after culling nodes that are not needed for model display. 

Effective for models that use skinning. 

Merge Useless Node In addition to the "Cull Useless Node" process, nodes that can compose a matrix 
are so composed for export. 

This extra process usually results in even fewer nodes than with just Cull 
Useless Node, but the following restriction applies to the Scale value: 

For nodes with children you must configure a non-uniform Scale (i.e., one where 
the Scale x, y, z values are not the same).  

The model may not display properly if you cull nodes that do not comply with this 
restriction and their children nodes. 

If the Scale value is animated, all frames must conform to the above restriction. 

Unite Nodes are combined into a singe node and all polygons are output in global 
coordinates. (The node takes the name world_root)

Polygons that belonged to separate nodes (the imd file's <polygon> elements) 
are output separately even if the material is the same. 

Do not select this mode when you are using character animation or visibility 
animation. 

Unite and Combine 
Polygon 

In addition to the Unite process, polygons with the same material are combined. 
However, polygons with vertex color will not be combined with polygons with no 
vertex color, and polygons with different render priorities will not be combined 
even if the material is the same. This boosts display speed over “Unite” but you 
lose the capacity for detailed clipping. 

Do not select this mode when you are using character animation or visibility 
animation. 

Note: If the node-culling disable flag is set for a node by the NITRO Set No Cut Node plug-in, then it 
will not be culled even if you have selected “Cull Useless Node” or “Merge Useless Node.” 

See 5.2 Node Culling Algorithms for details about the “Cull Useless Node” and “Merge Useless 
Node” algorithms. 
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• Compress Material 

Sets the material compression. “None” specifies no compression. 

“Compress Same Material” specifies that all materials which have the same attributes are 
compressed for export as a single material. Note that no compression takes place on materials 
configured for material color animation, texture pattern animation and texture SRT animation. 

Note: Materials will not be compressed even if Compress Same Material is specified if Compress has 
been set to Don’t compress with the NITRO Set Material Attribute plug-in. 

• Start / End Frame 

The range of animation (start frame to end frame) to export. 

If All is selected, the entire range of animation in Maya (Animation Start / End) will be output. 

If Playback is selected, the playback range of animation in Maya (Playback Start / End) will be 
output. 

If Range is selected, the start and end frames can be specified via input of a numeric value. 
However, if the input value for the start frame is smaller than the Animation Start frame in Maya, 
the Animation Start frame will become the start frame. If the input value for the end frame is 
larger than the Animation End in Maya, the Animation End frame will become the end frame. 

If an attribute is animated, the value in the start frame will be output to the imd file. 

3.2.3 Output File Selection 

Check the boxes to specify which types of Intermediate files to export. 

Figure 3-3  Output File Selection 
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3.2.4 Imd Options 

These are the options for imd files: 

Figure 3-4  Options for imd Files 

• Vertex Style 

Sets the export format for vertex coordinates and vertex color. 

Direct specifies direct output of vertex coordinates and vertex color values to the <polygon> 
element. 

Index specifies that the matrix of vertex coordinate values is output to the <vtx_pos_data> 
element and the matrix of vertex color values is output to the <vtx_color_data> element. The 
index values for all these matrices are output to the <polygon> element. 

The Index format is an extended format prepared for a future time when shape animation and 
vertex color animation can be supported. Normally you should use the Direct format, which is 
optimized for the NITRO Geometry Engine. 

• Output Texture 

This specifies the conditions for exporting textures to the imd file. 

Only Used specifies output of only those textures that are used in the model. 

“All” specifies output of all textures corresponding to the file nodes in the scene. 

• Force Full Weight 

When this is set to ON, the node with the largest weight value is forcedly exported with full 
weight (100% weight) even if the skinned model's vertex weight value is distributed among 
numerous nodes. If multiple nodes have the same weight value, then the node that gets 
exported with full weight is the node with the smallest index when the Compress Node option is 
“None.” When “Force Full Weight” is set to OFF, the weight value for each node is exported as-is. 

• Use Primitive Strip 

When set to OFF, polygon strips are not used, and polygons are output either as triangular or 
quadrilateral polygons. 

When set to ON, use triangular and quadrilateral polygon strips if possible, and output as 
triangular or quadrilateral polygons only the polygons that could not be made into strips. 
Compared to the OFF setting, the ON setting allows for a reduction in the number of processing 
vertices. 
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3.2.5 Animation Options 

The following options apply to animation in general: 

Figure 3-5  Animation Options 

• Interpolation 

Specifies a method of animation playback by obtaining a value in decimal frames.  

To round up decimal frames to handle as integer frames for the playback, use Frame without 
discarding the decimal frames. To use linear interpolation for the values in decimal frames, 
specify Linear.

With the G3D library released from the current NITRO-System, it is possible to play in-between 
frames by setting interpolation to linear. However, compared to frame, linear interpolation will 
slightly increase the CPU calculation process. 

If animation data does not require setting interpolation to linear, with respect to lightening the 
above-mentioned CPU processing load, be careful to output with interpolation set to frame.. 

As of February 2005, the G3D library only supports Linear for ica files. Ima files and ita files will 
play as Frame, even if Linear is specified. For information on the status of support for Linear with 
ima and ita files see the "G3D Library Release Notes". 

• Interpolate End Frame to Start Frame 

When this is set to ON, interpolation is conducted between the End frame and the Start frame 
when animation is played with interpolation. 

When this is set to OFF, the animation stops in the End frame state after the End frame. 

• Frame Step Mode 

Sets the extent of animation data culling. 

1 Do not cull; output the data from all frames. 

2 Output the data from every other frame (this reduces data volume to 1/2 original) 

4 Output the data from every fourth frame (this reduces data volume to 1/4 original) 

Auto Output the data after determining the optimal amount of culling automatically for each 
animation curve based on the settings of the Tolerance options. 
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Table 3-2  Frames Output According to Frame Step Mode 

Frame Step 
Mode Index of frames that get output 

1 0 1 2 3 4 5 6 7 8 9 0 11 12 13 14 15 

2 0 2 4 6 8 10  12  14 15 

4 0 4 8 12 13 14 15 

When the cull number does not divide evenly into (total number of frames - 1), all remainder data 
is output. 

3.2.6 Tolerance Options 

These settings define the amount of error to tolerate when optimizing the animation data. 

Figure 3-6  Tolerance Options 

If the largest differences in values between the Start frame and the various frames fall within the 
specified tolerable levels set here, then the animation values are considered to be uniform and only the 
Start frame value is exported. 

These specified tolerances are also used as the yardstick for the amount of error to tolerate when the 
Animation option “Frame Step Mode” is set to “Auto” and the decision on how much animation data to 
cull is determined automatically. The determined amount of culling is such that the maximum errors 
from linear interpolation falls within the tolerable values set here. The smaller the tolerable error, the 
higher the precision of the animation, but because there is less culling there is also a greater volume of 
data. 

• Node Translate, Node Rotate, Node Scale 

The tolerable error for the Translate, Rotate and Scale values of character animation. 

“Node Rotate” is expressed in units of degrees. 

“Node Translate” sets the tolerable error for the value after being multiplied by “Magnify.” If the 
Linear unit is not set to centimeters, this is will be the error tolerance of a value that is first 
converted to centimeters and then Magnified. 

• Texture Translate, Texture Rotate, Texture Scale 

The tolerable error for the Translate, Rotate and Scale values of texture SRT animation. 

“Texture Rotate” is expressed in units of degrees. 
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• Color 

The tolerable error for the diffuse, ambient, specular, emission, and polygon_alpha values of 
material color animation. 

3.3 Managing Option Settings  
To save option settings in a scene, or input and output them as an n3es (NITRO 3D Export Settings) 
file, use the items on the “NITRO Settings” menu on the “Options” window. 

Figure 3-7  NITRO Settings Menu 

3.3.1 Saving Option Settings in a Scene 

When “Save / Load Scene Settings” is ON (default), when you save a scene, the options that were set the 
last-time you output intermediate files will be saved in the scene data (Internally, they will be saved in a 
script node named nnsExpDialog_Setting1.). Then, these option settings that you saved with the 
scene data will be loaded when you open the scene (Set the Open Scene... option “Execute Script Nodes” 
to ON). If the option settings are not saved in the scene data, the current option settings will remain. 

When “Save / Load Scene Settings” is OFF, the options that were set the last-time you output 
intermediate files will not be saved in the scene data. Also, the option settings will not be loaded when 
you open the scene data. 

If you click “Delete Scene Settings,” the script node that holds the option settings will be deleted. 

3.3.2 Inputting and Outputting Option Settings as an n3es File 

To output option settings to an n3es file, click Save Settings to n3es File. You can specify an output 
file name in the file selection window. If the output file’s extension is not .n3es, n3es will be added 
automatically. 

To input option settings from an n3es file, click “Load Settings from n3es File.” You can specify an 
input file name in the file selection window. If “Save / Load Scene Settings” on the NITRO Settings 
menu is on, the script node that saves option settings during a scene will also be updated.. 
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3.4 Output From File > Export All (Selection) 
Although you can output intermediate files by going to File > Export All (Selection) and selecting 
“Nintendo_NITRO_System” as the File Type, in this case you will not be able to use such features as 
the one that transfers data to the 3D Material Editor, or the one that saves option settings in a scene. 
Therefore, in most cases use “Nintendo NITRO-System” > “NITRO Export” . If you do output 
intermediate files from “File” > “Export All (Selection)” , turn “Default File Extensions” OFF. The 
extensions of files specified in the file selection window will be ignored For example, even if you select 
abc.txt, if you are outputting imd and ica type intermediate files, the files will be output as abc.imd 
and abc.ica. You may also omit file extensions. Do not specify file names that contain full-width or 
half-width kana characters. 

3.5 Errors During Export 
Error messages are displayed in the Output Window when errors occur during export operations. 
Following is an alphabetical list of errors that warrant special attention. 

• 3D Material Editor is Not Found 

The 3D Material Editor has not been properly installed. If the NNS_3DME_ROOT environment 
variable is not set properly, fix it and restart Maya. 

• Cannot open file 

This error occurs if the file does not exist, cannot be opened, or cannot be overwritten. 

• Influence object is not output 

Nodes that are affected by skinning are not exported. This error occurs when the Template 
attribute of a node affected by skinning is set to ON, or when a node is made invisible by the 
Display Layer. 

• No effective node  

This error occurs when there is not even one valid node exported. If you only want to output 
locator, use the NITRO Set No Cut Node plug-in to set the cut-disable flag. 

• No shading group 

This means there is no shading group attached to the model. You need to assign a material. 

• Texture palette data is not identical 

This occurs when more than one texture is using palettes that have the same name, and the 
palette data in the palettes is different. If palette data content differs, when you make TGA and 
PIC files that have additional data, specify different palette names. 
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• Vertex number is different from original mesh 

There are times when, as a result of performing operations that change the number of vertices, 
the number of vertices for the model for which skinning was configured may differ from the 
number of vertices in the original mesh node (Orig). After performing a “Detach Skin” once, 
delete the history and then perform Bind Skin again. 

• Wrong weighted vertices exist 

There are vertices that have a total weight that is not 1.0. Adjust the weight value. If the 
Normalize Weights attribute of the skinCluster node is on, the total weight will automatically 
adjust to 1.0 when weights change.  

3.6 Warnings During Export 
Warnings are displayed in the Output window when they occur during export operations. Following is 
an alphabetical list of warnings that require special attention. 

• Can't Get UV 

No UV coordinates have been set for a texture-mapped face. UV coordinates for each of the 
face’s vertices will be exported as U=0, V=0. 

• Frame offset is not zero 

There is a frame with a file node Frame Offset attribute that is non-zero. This behavior is 
observed with Maya 6.0.1 and later versions. Note that the texture pattern animation will not be 
exported correctly. 

• Length of Name Over 16 characters 

A name to be exported to an intermediate file (node name, material name, texture image name, 
texture palette name) exceeds 16 characters. Problems may occur when these files use the 
Nintendo NITRO-System Library. 

• Material Name Changed 

A material name that will be exported to an intermediate file has been changed because there 
are duplicate material names. This will occur when for example one material is linked to multiple 
shading groups. 

• Mtx_prim_size of <polygon> is over 1 

The value of imd file <polygon> mtx_prim_size exceeds 1. This is generated by an 
envelope model in which more than 31 matrices are required to render a polygon group. 

As of February 2005, it is not possible to display this type of imd file with the G3D library that 
comes with the NINTENDO NITRO-System (binary conversion is not possible). For information 
on the latest G3D libraries, see "G3D Library Resource List". 

• No shader 

This means there is no material attached to the shading group. When this occurs, the plug-in 
automatically adds the default material to the Intermediate file for export. 
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• Node named changed 

Because several nodes with the same name exist, the node name output to the Intermediate file 
has changed. 

• Procedural texture is ignored 

Procedural textures like checker and ramp are not exported as-is (they are ignored). You need 
to use “Convert to File Texture” to convert these procedural textures into files and export them. 

• PSD file texture is ignored 

PSD file textures (psdFileTex nodes) are not exported. The PSD file textures will be ignored. 
This behavior is observed with Maya 6.0.1 and later versions. 

• Same-named texture file exists 

There are two or more texture files with the same name but in different folders or with differing 
file extensions. If two texture files have the same name, they will be treated as different files if 
they are in different folders or have differing file extensions. Note that this will output more than 
one <tex_image> with the same name. 

• Shear is not zero 

The transform node's Shear attribute has a non-zero value so it cannot be exported correctly. If 
this warning displays, execute “Freeze Transformations” or set all Shear attribute values to 0. 

• Size of texture is wrong 

The width or height of the texture is not usable by NITRO. (It should be 8, 16, 32, 64, 128, 256, 
512, or 1024.) The plug-in will automatically add the texel color to the right or bottom edge of the 
image so that it becomes an acceptable size for NITRO. 

• Texture pattern animation invalid frame extension 

This occurs when the texture that corresponds to the Frame Extension value in a specific frame 
is not output. 

Of the textures that are going to be output, the one closest to the Frame Extension value is 
output to the itp file. 

To avoid this warning, correct the animation curve or specify the texture to be forcibly output by 
the NITRO Set Frame Extension List plug-in. 

• Texture height must be power of 2 for repeat/flip 

If the place2dTexture node's “Wrap V” attribute or “Mirror V” attribute is set to ON, the texture will 
not display properly if the image height is not equal to 8 or a greater power of 2 (8, 16, 32, 64, 
128, 256, 512, 1024). If this message occurs, change the texture's height or set the “Wrap V” 
and “Mirror V” attributes to OFF 

• The number of matrices for displaying this model is over 31 

The number of matrices required to display the model exceeds 31. 
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• Texture width must be power of 2 for repeat/flip 

If the place2dTexture node's “Wrap U” attribute or “Mirror U” attribute is set to ON, the texture will 
not display properly if the image width is not equal to 8 or a greater power of 2 (8, 16, 32, 64, 
128, 256, 512, 1024). If this message occurs, change the texture's width or set the “Wrap U” and 
“Mirror U” attributes to OFF. 

• The Number of Matrix for Displaying This Model Over 31 

More than 31 matrices are required to render this model. The number that follows the warning 
message is the current number of matrices. 

• Total polygon size over 

The total number of polygons has exceeded the size of NITRO's polygon list RAM. This means 
you will not be able to display all of the polygons at the same time. The maximum number of 
polygons is 2048 triangles or 1706 quadrangles. 

If triangles and quadrangles are mixed, the following condition must be met: 

The number of triangles × 20 + the number of quadrangles × 24 ≤ 40960 

• Total vertex size over 

The total number of Vertex commands has exceeded the size of NITRO's vertex RAM (6144 
vertices). This means you will not be able to display all of the polygons at the same time.  

• UV range over 

This means that the texture coordinate (UV value) exceeds the limitations of NITRO. Change the 
UV value so that it matches the conditions explained in “2.11.4 UV Limitations.” 

• Zero normal exist 

There is a normal vector whose length is 0. This means that lighting will not perform correctly. 

3.7 Batch Export of Intermediate Files 

3.7.1 Batch Export 

Besides the usual method of outputting intermediate files by opening a scene in Maya, intermediate 
files can be output to one or more scenes at once by starting up Maya in a mode that does not display 
a user interface. 

This is called “batch export.” 

3.7.2 How to Run a Batch Export 

(1) Prepare the n3be file. 

The n3be file is a file that specifies which intermediate file to output to which scene under what  
conditions. Prepare a file according to the separate document NITRO_n3beFileFormat.pdf.
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(2) Run a batch export using NNS_Batch_Export_Maya**.bat and n3be files in 
NNS_Maya**_Plugin folder. (** indicates 50, 60, 65, 7.0, or 8.0.) 

Note: NNS_Batch_Export_Maya**.bat needs to be corrected according to 
Setup_MayaPlugin.pdf.

Run the batch export by entering the following at the command prompt: 

NNS_Batch_Export_Maya**.bat  sample.n3be  [Enter] 

You can also run it by dragging and dropping a n3be file to NNS_Batch_Export_Maya**.bat.

If the batch export completes properly, the following message will appear at the end: 

Batch Export is finished. Total [number of scenes] scenes. 

If there is a problem with the description of the n3be file, an error message appears and the 
process is aborted (terminated) at that point. 

Major error messages are shown below. 

Error: "***" is not specified. 
Error: "***" is wrong. 

If an error occurs with the output of the intermediate file while the batch export is running, the 
following error message appears: 

Error: Failed to export 
The process is aborted (terminated) at that point. 

The description of errors and warnings regarding the output of intermediate files is output to the 
log file specified with n3be file. 

3.7.3 Supplemental Remarks on Batch Export 

To run a batch export, a n3es file is required. 

To specify which options to use to output intermediate files, specify a n3es file in the n3be file. Even if 
the output option setting is saved in the scene file, the batch export will not reference it and always 
uses the setting in the n3es file. 
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4 Data Creation Plug-Ins 
The Data Creation plug-ins assist in the creation of data for NITRO. 

These plug-ins are primarily used on Maya nodes to configure and check the attributes for use with 
NITRO. All components of this Data Creation plug-in can be executed from the Nintendo NITRO-
System menu. 

The following table lists data creation plug-ins. 

Table 4-1  Data Creation Plug-ins 

Plug-in Name Description 

NITRO Set Material Attribute Sets NITRO attributes in a material 

NITRO Show Lighting Checks lighting settings 

NITRO Show Display Face Checks polygon display face settings 

NITRO Set Render Priority Sets polygon rendering priority 

NITRO Show Render Priority Checks polygon rendering priority settings 

NITRO Set Billboard Sets the billboard 

NITRO Show Billboard Checks billboard settings 

NITRO Set No Cut Node Sets the flag that disables node cutting 

NITRO Show No Cut Node Checks the setting of the flag that disables node cutting 

NITRO Set Frame Extension List Sets the texture to be output by texture pattern animation 

NITRO Replace Character Searches and replaces element name character strings 

NITRO Rename Over 16 Characters Searches for and renames element names that exceed 16 characters 

4.1 Setting Material Attributes (NITRO Set Material Attribute) 
NITRO's polygon attributes and the attributes for such things as the texture coordinates transform 
mode are exported to the Intermediate file in the form of material attributes. These material attributes 
for NITRO are configured for individual shading groups using the NITRO Set Material Attribute plug-in. 
Note that these settings are not reflected in the Maya screen. 

Select a shading group (shadingEngine node) or a material node (Lambert node, etc.) and then 
execute “Nintendo NITRO-System” > “NITRO Set Material Attribute.” (You can select multiple nodes.) 
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Figure 4-1  NITRO Set Material Attribute Window 

The window displays the selected node's current settings. If you select multiple nodes, the window 
displays the settings of the first node that was selected. 

Operate the various items in the window to change different attributes. If you select multiple nodes, you 
can change them all at once (reflected only in the changed items). 

You can close this window and select a different node to configure the attributes of that node. 

• Light0, Light1, Light2, Light3 

Specifies the light that is affected when it is displayed on NITRO. It is not reflected on the Maya 
display. By default, Light0 is set to ON, and Light1, Light2, and Light3 are set to OFF. 

When any of these lights are on, the normal data of the polygon that belongs to the shading 
group is output. When all of the lights are off, the normal data is not output. 

• Use Specular Reflection Shininess Table 

Specifies whether to use the Specular Reflection Shininess Table when calculating specular 
components. By default, it is set to OFF. 
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When Light0, Light1, Light2, and Light3 are all set to OFF, this attribute cannot be changed, and 
in the intermediate file it is output as OFF. 

• Fog 

Specifies whether to apply fog. The default is OFF. 

• Wire Frame 

This check box toggles wireframe display on/off. The default is OFF. 

• Depth Test for Decal Polygons 

This specifies whether to do a depth test for decal polygons. When it is on, there will be a depth 
test for decal polygons. When the depth value of a fragment is the same as the depth in the 
depth buffer, it will be rendered. When it is off, there will be a normal polygon depth test: when 
the depth of a fragment is less than the depth in the depth buffer it will be rendered. The default 
is off. 

Render decal polygons after the polygons on which they will be mapped. You can control 
polygon group rendering order with the NITRO Set Render Priority plug-in. 

• Translucent Polygons Update Depth Buffer 

This specifies whether to update the depth buffer when rendering translucent polygons. The 
default is off. 

• Render 1-pixel Polygon 

This specifies whether to render one-pixel (dot) polygons. The default is off. 

• Far Clipping 

This specifies whether to do FAR clipping. When it is on, polygons that intersect the far plane will 
be clipped. When it is off, polygons that intersect the far plane will be deleted. The default is off. 

• Polygon ID 

Sets the polygon ID. Specify a value between 0 and 63. The default is 0. 

• Display Face 

This specifies the polygon's display face. 

Front Face = Display the front face only 
Back Face = Display the back face only 
Both Faces = Display both faces 

The default is Front Face. 

• Polygon Mode 

Sets the polygon mode. 

Modulate = Modulation mode 
Decal = Decal mode 
Toon/Highlight = Toon/highlight shading  
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Shadow = Shadow polygons 

The default is Modulate. 

• Tex Gen Mode 

Sets the texture coordinates transform mode. 

None = Do not transform the texture coordinates 
TexCoord = TexCoord source 
Normal = Normal source  
Vertex = Vertex source 

The default is None. 

When performing environmental mapping, use Normal. When performing projection mapping, 
use Vertex. 

If the attribute is set to None, the data nevertheless will be exported as TexCoord if the material 
is attached to a texture whose texture matrix is not an identity matrix. (If the mode is set to 
Normal or Vertex, the texture matrix will not affect what is exported.) 

• Tex Gen ST Source 
When the texture coordinate conversion mode is Normal or Vertex, specify whether or not the 
texture coordinates of the corresponding polygons will be output.  
Polygon outputs the texture coordinates of the polygons. Special mapping expressions are 
possible, such as transformation of standard attached textures via normal vectors or vertex 
coordinates. 
Material does not output the texture coordinates of the polygon. The Maya attachment method is 
ignored, and the texture coordinates are determined from the normal vector or the vertex 
coordinates. When performing general environmental or projection mapping, use Material. 
This is set to Material by default. 

• Texture Effect Matrix 
When the texture coordinate conversion mode is Normal or Vertex, specify a 4x2 matrix that 
influences the texture coordinate conversion. When performing environmental / projection 
mapping, etc., This matrix can be used in adjusting the position, direction, and size of the texture. 
By inputting a numeric value and pressing the Enter key, it will be converted to a value that 
NITRO can use (a multiple of 1/4096). The following table describes each component of the 
matrix. 

Table 4-2  Texture Effect Matrix Components 

The influence of the X coordinate on the S coordinate The influence of the X coordinate on the T coordinate 

The influence of the Y coordinate on the S coordinate The influence of the Y coordinate on the T coordinate 

The influence of the Z coordinate on the S coordinate The influence of the Z coordinate on the T coordinate 

The amount of the S coordinate offset The amount of the T coordinate offset 

Note: A 4x4 matrix outputs the Intermediate File, but since the third and fourth lines have no 



NITRO Intermediate File Plug-in for Maya 

NTR-06-0008-001-B 42  2004-2006 Nintendo 
Released: October 12, 2006  CONFIDENTIAL 

influence on the texture coordinate conversion, with the plug-in this in effect becomes a 
4x2 matrix where only the first and second lines can be configured. 

Note: When the Tex Gen ST Source is Polygon, the component on the fourth line has no effect. 

Cautions for the G3D Library Provided by NINTENDO NITRO-System 

With the G3D library, the XYZ coordinates that multiply to the Texture Effect Matrix are as follows: 

Environmental Mapping (Tex Gen Mode = Normal) 

The coordinates where a normal vector was converted to a view-coordinate type. 

Projection Mapping (Tex Gen Mode = Vertex) 

The coordinates where the vertex coordinates were converted to a world-coordinate type. 

After applying these coordinates to the Texture Effect Matrix, the coordinates that were applied to the 

“Matrix for Aligning the Center and Position of the Mapping” and the “Texture Scale and Rotate Matrix 

Designated by the Material” become the final texture coordinates. 

For environmental mapping, the fourth line of the Texture Effect Matrix has no effect. 

Environmental and projection mapping cannot display properly for the envelope model. 

• Compress 

This sets the flag indicating whether to compress when the Compress Material option is set to 
“Compress.” 

Compress if possible = Compress if the attributes are the same as those of other materials. 
This is the default setting. Note that even when this setting is selected the material will not 
be compressed if material color animation, texture pattern animation or texture SRT 
animation has been configured. 

Don’t compress = Export as an independent material without compression, even if its 
attributes are the same as those of other materials. 

4.2 Checking the Lighting (NITRO Show Lighting) 

Execute by clicking on Nintendo NITRO-System > NITRO Show Lighting. 



NITRO Intermediate File Plug-in for MAYA 

 2004-2006 Nintendo 43 NTR-06-0008-001-B 
CONFIDENTIAL  Released: October 12, 2006 

Figure 4-2  NITRO Show Lighting Window 

When executed, a Window will appear. Click a radio button to display the shading groups set for that 
mode and the polygons that belong to the shading groups in the selected state. 

Off  not affected by any light 

Light0 On affected by Light0 

Light1 On affected by Light1 

Light2 On affected by Light2 

Light3 On  affected by Light3 

Any Light On affected by any light 

You can get a better idea of the results by selecting “Rendering” > “Show ShadingGroups in 
Hypergraph.” 

When “Keep Selection” is set to ON, the pertinent shading groups and the polygons that belong to the 
shading groups can be maintained in their selected state after the window is closed. When it is set to 
OFF, the selection state reverts to what it was prior to the execution of “NITRO Show Lighting.” 
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4.3 Checking the Polygon Display Surface (NITRO Show Display Face) 

Execute by clicking on “Nintendo NITRO-System” > “NITRO Show Display Face.” 

Figure 4-3  NITRO Show Display Face Window 

Click on a polygon “Display Face” mode in the window that opens up to display the shading groups set 
for that mode and the polygons that belong to the shading groups in the selected state. 

You can get a better idea of the results by selecting “Rendering” > “Show ShadingGroups in 
Hypergraph.” 

When “Keep Selection” is set to ON, the pertinent shading groups and the polygons that belong to the 
shading groups can be maintained in their selected state after the window is closed. When it is set to 
OFF, the selection state reverts to what it was prior to the execution of “NITRO Show Display Face.” 

4.4 Polygon Rendering Priority Setting (NITRO Set Render Priority) 
The NITRO Set Render Priority plug-in sets polygon rendering priority for shading groups. For 
information on polygon rendering priority see 2.7.9 Polygon Rendering Priority. 

Run NINTENDO NITRO-System > NITRO Set Render Priority after selecting a shading group 
(shadingEngine node) or a material node (Lambert node, etc.). Multiple selections are possible. 

Figure 4-4  NITRO Set Rendering Priority Window 
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The window displays the current settings for the selected node. In the case of multiple selections it 
shows the settings for the node that was selected first.  

Use the radio button to the right of Render Priority to select either Don't care (no rendering priority 
specification) or select a numerical specification. If you specify a number, enter an integer from 1 to 
255 and press the Enter key. Polygons that belong to shading groups with lower numbers will be 
rendered first. If multiple shading groups have the same number, which shading group's polygons will 
be rendered first is indeterminate (it depends on the rendering routine). 

If you select another node without closing the window you will be able to set that node. 

4.5 Checking Polygon Rendering Priority (NITRO Show Render 
Priority) 

Click NINTENDO NITRO-System > NITRO Show Render Priority to run it. 

Figure 4-5  NITRO Show Rendering Priority Window 

When you run the plug-in, this window will open. If you use the radio button to the right of Render 
Priority to select Don't care (do not specify rendering order) or to select condition specification and 
specify a condition, the relevant shading groups and polygons that belong to them will be displayed as 
selected. You can set the following conditions: less than (<: under), less than or equal to (<=: below), 
equal to (=: exactly), greater than or equal to (>=: above), greater than (>: over). You can use integers 
1 through 255. 

It will be easier to see the results if in Hypergraph you set Rendering > Show ShadingGroups. 

If you select Keep Selection, the shading groups and the polygons that belong to the shading groups 
will remain in selected state even after the window is closed. If this item is off, they will return to the 
selection status before you ran NITRO Show Render Priority. 
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4.6 Setting the Billboard (NITRO Set Billboard) 

Billboard is set for transform nodes and joint nodes using the NITRO Set Billboard plug-in. Note that 
the settings are not reflected on the Maya screen. 

Select a transform node or a joint node (you can select multiple nodes) and then click on “Nintendo 
NITRO-System” > “NITRO Set Billboard” to execute. 

Figure 4-6  NITRO Set Billboard Window 

The window shows the current settings of the selected node. If you have selected multiple nodes, the 
window shows the settings of the last selected node. 

Click on the combo box to change the billboard mode. If multiple nodes are selected, all selected 
nodes can be changed at the same time. 

No Billboard = No billboard 
Billboard = Always display in the direction of the camera  
Y-Billboard = Display in the direction of the camera, centered along the global Y axis 

If you select another node without closing the window you can set that other node. 

4.7 Checking the Billboard (NITRO Show Billboard) 
Execute by clicking on Nintendo NITRO-System > NITRO Show Billboard. 

Figure 4-7  NITRO Show Billboard Window 

Click on a billboard mode in the window that opens up to display the transform nodes and joint nodes 
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that have been set to that mode in the selected state.  

When “Keep Selection” is set to ON, the pertinent nodes can be maintained in their selected state after 
the window is closed. When it is set to OFF, the selection state reverts to what it was prior to the 
execution of “NITRO Show Billboard.” 

4.8 Setting the Node-Culling Disable Flag (NITRO Set No Cut Node) 
The NITRO Set No Cut Node plug-in sets the flag for transform nodes and joint nodes such that even 
when the node-culling feature is enabled the nodes are not culled when the Intermediate file is output. 

Select a transform node or a joint node (you can select multiple nodes) and then click on “Nintendo 
NITRO-System” > “NITRO Set No Cut Node” to execute. 

Figure 4-8  NITRO Set No Cut Node Window 

The window shows the current settings of the selected node. If you have selected multiple nodes, the 
window shows the settings of the last selected node. 

Click on the combo box to change the flag that disables node culling. If multiple nodes are selected, all 
selected nodes can be changed at the same time. 

“Cut this node if possible” = When the node-culling feature is enabled, cull nodes that can be culled. 
This is the default setting. 

“Don’t cut this node” = Do not cull nodes even if the node-culling feature is enabled. 

If you select another node without closing the window you can set that other node. 

4.9 Checking the Node-Culling Disable Flag (NITRO Show No Cut Node) 
Execute by clicking on “Nintendo NITRO-System” > “NITRO Show No Cut Node.” 

When this executes, those transform nodes and joint nodes that have the flag that disables node 
culling set to “Don’t cut this node” are shown in the selected state. 
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4.10 Setting the Textures Exported with Texture Pattern Animation 
(NITRO Set Frame Extension List) 

By default, the only textures that are exported to the Intermediate file for texture pattern animation are 
those textures specified with a file node Image Name attribute and textures that correspond to keyed 
Frame Extension attributes. However, you can use the NITRO Set Frame Extension List plug-in to 
forcibly export textures corresponding to specific frame extensions. 

Select only one file node (or material node) and the click “Nintendo NITRO-System” > “NITRO Set 
Frame Extension List” to execute. 

Figure 4-9  NITRO Set Frame Extension List Window 

In the resulting window, enter a list of texture numbers (frame extensions) to export to the Intermediate file. 

The format is: 1,2,3... Separate each number with a comma. If the file node's Image Name is 
name.1.tga then the three textures name.1.tga, name.2.tga, and name.3.tga will be exported 
even if they do not correspond to keyed Frame Extension attributes. 

If no corresponding texture exists for a specified number, an error will be generated when data are 
exported. A negative number cannot be specified for a texture number. 

A series of numbers (e.g., "1,2,3,4,5") can be written as a range separated using a hyphen (e.g., 1-5) 

Entering "3-6,10" is the same as entering "3,4,5,6,10." 

You can use a space in place of a comma to separate numbers. 

Entries made in the following formats will generate errors:  

1-3-5 Error because two or more values are separated using hyphens 
-3 Error because value begins with a hyphen 
5- Error because value ends with a hyphen 
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4.11 Replace Element Name Character Strings (NITRO Replace 
Character) 

This plug-in collectively replaces element name character strings (object name, material name). You 
can also change element name characters from uppercase to lowercase, or from lowercase to 
uppercase. 

To use this plug-in, select Start > NINTENDO NITRO-System > NITRO Replace Character.

Figure 4-10  NITRO Replace Character Window 

Use the Filter check boxes to select an element type (you may select more than one). 

Use Option > Replace Mode to select a replace mode.. 

• Character Sequence 
Replaces the search string in the text box on the left with the replace string in the text box 
on the right. 
When Match Case is checked, the plug-in only returns exact, case-sensitive matches. 
When this option is unchecked, it returns any (and all) items that match the search string. 
Use the following symbols at the beginning of the search string to limit the search and 
replace to the beginning or end of the element name. 
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o “^”
Indicates the beginning of the target element name. If you only enter “^” in the 
search field, the replace character string is appended before the target element name. 
For example: 
[^cube] >> [box] only replaces instances of [cube] to [box] when “cube” exist at the 
beginning of an element name. 
[^] >> [cube] appends the character string, [cube], to the front of the target element 
name. 

o “$”
Indicates the end of the element name. If you only enter “$” in the search field, the 
replace character string is appended at the end of the targeted element name. For 
example: 
[$ test] >> [ ] will delete [ test] from any element name that ends with [ test]. 
[$] >> [ test] appends [ test] to the end of the target element names. 

• Lowercase to Uppercase 
Converts all lowercase letters to uppercase letters. 

• Uppercase to Lowercase 
Converts all uppercase letters to lowercase letters. 

When you click the Search button, the results of the search (current element names and the element 
names after replacement) appear in the Search Result box. However, elements whose names cannot 
be changed (lambert1, etc) will not be listed. 

From the list, select the element names that you want to replace (will also be selected by Maya). 
Immediately after you click the Search button, all of the elements in the list will be selected. Ctrl + Left-
click will switch the select status of individual elements. Click the Select All button to select all of the 
elements in the list. 

Note: If an element name is not displayed in the “After” column, a blank replace string causes all of 
the characters in the file name to be deleted, resulting in an element with no file name. These 
will not be replaced, even if selected. Therefore you must redo the settings. 

Replacement actually takes place when you click the Apply button. A warning dialog appears if either 
the new name already exists in the scene or if it is an element name that cannot be used by Maya. 

Note: Although an error or warning appears if you can still click Apply while the Attribute Editor is 
open, the character string is still properly replaced. 
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4.12 Rename Element Names That Exceed 16 Characters (NITRO 
Rename Over 16 Characters) 

This plug-in searches for and replaces the names of elements (node name, material name, texture 
image name, texture palette name) which exceed the 16-character limit so that you can export them to 
intermediate files. 

To use this plug-in, select Start > NINTENDO NITRO-System > NITRO Rename Over 16 Characters.

Figure 4-11  NITRO Rename Over 16 Characters Window 

Designate the range parameter by using one of the radio button options in the Target section of this 
window. 

• All — Select this option if you are going to export an entire scene as intermediate files. 
• Selection —Select this option if you are going to export only a node and its sub-nodes. 

Next, if you chose Selection as your Target, use Maya to select the export target node. You need not 
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select a node if chose All.

When you click the Search button, a list of the elements set for export to intermediate files whose 
names exceed 16 characters appears in the Target List section (will be selected in Maya). The 
displayed results are those for the case in which the intermediate file export options “Compress Node” 
and “Compress Material” are set to “None”, and the option “Output Texture” is set to “Only Used”. If a 
file node's texture file name is blank, a warning is displayed if the texture file cannot be opened. 

For objects and materials: the in Maya column lists the names as they are in Maya, the in imd column 
lists the file names as they are in the intermediate file. For textures, the Image column lists the texture 
image names and the Palette column lists the texture palette names. Items that do not exceed 16 
characters are grayed–out in the display. 

In the Object section, hovering over an item (moving your pointer over an item and leaving it there 
momentarily) in the in Maya column displays its full pathname as a ToolTip (in a temporary popup box). 
Hovering over an item in the Image or Palette column in the Texture section displays the full pathname 
(for that particular item) as a ToolTip. 

Next, type a new name in the Rename column. You can not use the following names: 

• Names that cannot be used as Maya node names 
• Names that exceed 16 characters 
• Names that are already used as node names in the scene. 
• Names that duplicate other Rename names. 

 
When you click the Apply button, the names are changed. However, elements whose Rename names 
would become blank are not changed. Entries whose names have changed will be selected in Maya 
and removed from the Target List. 

When you click the Output Text File button, the current Target List is written to a text file. In the case 
of textures, the texture file path name is also included in the output. This feature is useful when, for 
example, you later wish to collectively revise texture file and palette names. It is also useful for later 
confirming element names before and after changing. 
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5 Information for Programmers 

5.1 Node Matrices in Maya 
Maya has two types of nodes that correspond to the imd file's <node> element. These are the 
transform node and the joint node. 

With coordinates multiplied starting from the left, the transform node matrix is: 

[S] * [R] * [T] 
[S] = Scale matrix 
[R] = Rotate matrix 
[T] = Translate matrix 

Maya's joint node has what is known as a Segment Scale Compensate attribute. When this attribute is 
OFF, the joint node matrix is the same as the transform node matrix. But when this attribute is ON, the 
joint node matrix is as follows: 

[S] * [R] * [IS] * [T] 
[IS] = the parent's Scale inverse matrix 

The parent's Scale only affects the child's Translate. 

When you execute the Intermediate File Output plug-in, the scale_compensate attribute – which 
defines whether to perform scale compensation – is exported to the imd file's <node> elements. 
Because of this, the program that calculates matrices needs to select one or the other of these two 
methods in accordance with this attribute for each <node> element. 

If the scale_compensate attribute is set to ON for even one <node> element, then the imd file 
<model_info> element's scaling_rule attribute will be set to maya. Otherwise, the 
scaling_rule attribute will be set to normal.

5.2 Node Culling Algorithms 

5.2.1 Algorithm for the “Cull Useless Node” Specification 

1.  Cull a node if it does not have children and is not used in display of matrix (i.e., the node is not 
used in the envelope). If the node holds polygons, move them to the root node. 

2.  Repeat step 1 until there are no more nodes to cull. 

3.  Lastly, if the root node world_root added by the plug-in has one child node, cull world_root 
as well and move any polygons held by world_root to its child node. 



NITRO Intermediate File Plug-in for Maya 

NTR-06-0008-001-B 54  2004-2006 Nintendo 
Released: October 12, 2006  CONFIDENTIAL 

5.2.2 Algorithm for the “Merge Useless Node” Specification  

1.  First perform the same steps taken by the “Cull Useless Node” algorithm. 

2.  Look at the nodes that remain (other than the root node). If a node's parent node's matrix is not 
used for display, merge that node's matrix with its parent node matrix and cull the parent node. If 
that parent node has multiple child nodes, do this merging process for each child node. If the 
parent node holds polygons, move those polygons to the root node. 

3.  Repeat step 2 until there are no more nodes to cull. 

4.  Lastly, also cull the root node if it has one child node and its matrix is not being used for display. 
Move the root node's polygons to the child node. 
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5.2.3 Examples of Node Culling 

Figure 5-1  Examples of Node Culling 

Group 1

Joint 1Shape 1

Shape 3Shape 2

Joint 3

Joint 2

Joint 1

Joint 2

Group 1

Joint 3

Joint 3

Joint 1

Polygon 1

Polygon 2 Polygon 3

1 No node culling

Nodes  used for
displaying the matrix

Nodes not used for
displaying the matrix

2 Cull Useless Node

Polygon 1
Polygon 2
Polygon 3

3 Merge Useless Node

Polygon 1
Polygon 2
Polygon 3

1. Shape 2, which does not have a child, is culled
and polygon 2 is moved to group 1, which is the
root node.

2. Similarly, childless shape 3  is culled and
polygon 3 is moved to group 1.

3. Shape 1's children are gone, so it is culled too
and polygon 1 is moved to group 1

1. Joint 2 is culled and its matrix is merged
into joint 3.

2. Group 1 is culled and its matrix is merged
into joint 1.  Polygons 1, 2, & 3 are moved to
joint 1.
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5.3 Texture Matrices in Maya 
The method used for creating the texture coordinate transformation matrix for NITRO from the texture 
Scale value, Rotate value, and Translate value exported from Maya is shown in Code 5-1. 

Code 5-1  Texture Matrix 

// For this texture matrix, the Scale values of ST are Ss, St 
// The Rotate value is R, sin(R) is sinR, cos(R) is cosR 
// The Translate values of ST are Ts, Tt
// The Texture's image width is W (<tex_image> @ original_width) 
// The Texture's image height is H (<tex_image> @ original_height) 
 
const int MTX_-SHIFT = 12; 
s32 ss_sin = (s32)((s64)Ss * sinR >> MTX_SHIFT); 
s32 ss_cos = (s32)((s64)Ss * cosR >> MTX_SHIFT); 
s32 st_sin = (s32)((s64)St * sinR >> MTX_SHIFT); 
s32 st_cos = (s32)((s64)St * cosR >> MTX_SHIFT); 
 
m[ 0] = ss_cos; 
m[ 1] = st_sin * (-H) / W;  
m[ 2] = 0 
m[ 3] = 0 
m[ 4] = ss_sin * W / H; 
m[ 5] = st_cos; 
m[ 6] = 0 
m[ 7] = 0 
m[ 8] = 0 
m[ 9] = 0 
m[10] = 0 
m[11] = 0 
m[12] = ((-ss_sin - ss_cos + Ss) * W << 3) 
 - (s32)((s64)Ss * Ts >> MTX_SHIFT - 4) * W; 
m[13] = (( st_sin - st_cos - St + (2 << MTX_SHIFT)) * H << 3) 
 + (s32)((s64)St * Tt >> MTX_SHIFT - 4) * H; 
m[14] = 0; 
m[15] = 1 << MTX_SHIFT; 
// ss, st, sinR, cosR, ts, tt are 12-bit fixed-point decimals 
// W and H are integers with no decimal 
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5.4 Extra Attributes 
The Intermediate File Export Plug-in uses a number of extra attributes. These "custom" attributes all 
have nns_ at the start of their name. 

Table 5-1  List of Extra Attributes 

Type Node Type Attribute Name Attribute 
Type Meaning of Values 

Light0 enable flag shadingEngine nns_lighting bool 0 = Not affected by Light0  

1 = Affected by Light0 

Light1 enable flag shadingEngine nns_lighting1 bool 0 = Not affected by Light1 

1 = Affected by Light1 

Light2 enable flag shadingEngine nns_lighting2 bool 0 = Not affected by Light2 

1 = Affected by Light2 

Light3 enable flag shadingEngine nns_lighting3 bool 0 = Not affected by Light3 

1 = Affected by Light3 

Specular Reflection 
Shininess Table enable 
flag 

shadingEngine nns_shininess_table bool 0 = Does not use Specular 
Reflection Shininess Table 

1 = Use Specular Reflection 
Shininess Table 

Fog enable flag shadingEngine nns_fog bool 0 = Does not apply fog 

1 = Apply fog 

Wireframe display flag shadingEngine nns_wire_mode bool 0 = Wire Frame display ON 

1 = Wire Frame display OFF 

Decal polygon depth 
test flag 

shadingEngine nns_depth_test_decal bool 0= Does not do depth test for 
decal polygons 

1= Does depth test for decal 
polygons 

Translucent polygon 
depth value update flag 

shadingEngine nns_xlu_update_depth bool 0= Does not update depth buffer 
when rendering translucent 
polygons 

1= Updates depth buffer when 
rendering translucent polygons 

1-dot polygon rendering 
flag 

shadingEngine nns_render_1_pixel bool 0= Does not render 1-dot polygons 

1= Renders 1 dot polygons 

FAR clipping flag shadingEngine nns_far_clip bool 0= Deletes if intersects FAR plane 

1= Clips if intersects FAR plane 

Polygon ID shadingEngine nns_poly_id short Polygon ID value (0—63) 

Polygon's display face shadingEngine nns_disp_face enum 0 = Display front face 

1 = Display back face 

2 = Display both faces 
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Type Node Type Attribute Name Attribute 
Type Meaning of Values 

Polygon mode shadingEngine nns_poly_mode enum 0 = Modulation mode 

1 = Decal mode 

2 = Toon / Highlight shading 

3 = Shadow polygon 

Texture coordinates 
transform mode 

shadingEngine nns_tex_gen_mode enum 0 = Do not transform texture 
coordinates 

1 = TexCoord source 

2 = Normal source 

3 = Vertex source 

Texture coordinate 
output flag for when the 
texture coordinate 
conversion mode is 
Normal or Vertex 

shadingEngine nns_tex_gen_st_src enum 0 = Output polygon's texture 
coordinates 
1 = Do not output polygon’s 
texture coordinates. 

Matrix that influences 
texture coordinate 
conversion 

shadingEngine nns_tex_effect_mtx matrix 4x4 matrix 

T value used for texture 
coordinate 
transformation 

shadingEngine Nns_tex_gen_t float T value (-2048—2047.9375) 

Material compression-
disable flag 

shadingEngine nns_no_compress bool 0 = Compression OK 

1 = No compression  

Use polygon rendering 
priority flag 

shadingEngine nns_use_render_priority bool 0= Does not use rendering 
priority (Don’t care) 

1= Uses rendering priority 

Polygon rendering 
priority 

shadingEngine nns_render_priority short Rendering priority value (1-255) 

Billboard transform nns_billboard enum 0 = None 

1 = Billboard 

2 = Y-axis billboard 

Node culling-disable 
flag 

transform nns_no_cut bool 0 = Culling OK 

1 = Do not cull 

Frame Extension list for 
texture pattern 
animation 

file nns_fe_list string List of numbers to forcedly export



NITRO Intermediate File Plug-in for MAYA 

 2004-2006 Nintendo 59 NTR-06-0008-001-B 
CONFIDENTIAL  Released: October 12, 2006 

Windows is a registered trademark or trademark of Microsoft Corporation (USA) in the U.S. and other countries. 

Maya is a registered trademark of Autodesk, Inc / Autodesk Canada, Inc. in the United States and/or other 
countries. 

Photoshop and Adobe are registered trademarks or trademarks of Adobe Systems Incorporated. 

All other company names and product names are the trademark or registered trademark of the respective companies. 



NITRO Intermediate File Plug-in for Maya 

NTR-06-0008-001-B 60  2004-2006 Nintendo 
Released: October 12, 2006  CONFIDENTIAL 

 

© 2004-2006 Nintendo 
 
The contents of this document cannot be 
duplicated, copied, reprinted, transferred, 
distributed or loaned in whole or in part without 
the prior approval of Nintendo. 


	1 Intermediate File Types
	2 Precautions Regarding Creation Data for NITRO
	2.1 Maya Version
	2.2 Preference Settings
	2.3 Nodes
	2.3.1 Root Node
	2.3.2 Nodes Not Exported
	2.3.3 Culling Nodes Not Needed for Model Display
	2.3.4 Node Names

	2.4 Animation
	2.4.1 Time Axis
	2.4.2 Values Exported to the imd File

	2.5 Transform Node
	2.6 Joint Node
	2.7 Polygon Models
	2.7.1 Polygon Shapes
	2.7.2 Setting the Display Face
	2.7.3 Vertex Color
	2.7.4 Instances
	2.7.5 Limitations of Combine
	2.7.6 Vertex Translate Animation Prohibited
	2.7.7 Proxy Shapes
	2.7.8 Number of Valid mesh Nodes
	2.7.9 Polygon Rendering Priority

	2.8 NURBS Models
	2.9 Subdivision Surfaces
	2.10 Materials
	2.10.1 Material Types and Attributes
	2.10.2 Material Names
	2.10.3 Material Color Animation

	2.11 Textures
	2.11.1 Texture Nodes
	2.11.2 Texture Files and Format
	2.11.3 Texture Attributes

	2.12 UV Limitations
	2.12.1 Texture Pattern Animation
	2.12.2 Texture SRT Animation

	2.13 Skinning
	2.13.1 Skinning Settings
	2.13.2 Delete Skinning
	2.13.3 Influence Objects
	2.13.4 Skinning and Projection Mapping
	2.13.5 Polygon Shapes Output to the imd File
	2.13.6 Envelopes in NINTENDO NITRO-System

	2.14 Visibility Animation
	2.15 Billboard

	3 Intermediate File Export Plug-In
	3.1 How to Use
	3.2 Options
	3.2.1 Output Options
	3.2.2 General Options
	3.2.3 Output File Selection
	3.2.4 Imd Options
	3.2.5 Animation Options
	3.2.6 Tolerance Options

	3.3 Managing Option Settings
	3.3.1 Saving Option Settings in a Scene
	3.3.2 Inputting and Outputting Option Settings as an n3es File

	3.4 Output From File > Export All (Selection)
	3.5 Errors During Export
	3.6 Warnings During Export
	3.7 Batch Export of Intermediate Files
	3.7.1 Batch Export
	3.7.2 How to Run a Batch Export
	3.7.3 Supplemental Remarks on Batch Export


	4 Data Creation Plug-Ins
	4.1 Setting Material Attributes (NITRO Set Material Attribute)
	4.2 Checking the Lighting (NITRO Show Lighting)
	4.3 Checking the Polygon Display Surface (NITRO Show Display Face)
	4.4 Polygon Rendering Priority Setting (NITRO Set Render Priority)
	4.5 Checking Polygon Rendering Priority (NITRO Show Render Priority)
	4.6 Setting the Billboard (NITRO Set Billboard)
	4.7 Checking the Billboard (NITRO Show Billboard)
	4.8 Setting the Node-Culling Disable Flag (NITRO Set No Cut Node)
	4.9 Checking the Node-Culling Disable Flag (NITRO Show No Cut Node)
	4.10 Setting the Textures Exported with Texture Pattern Animation (NITRO Set Frame Extension List)
	4.11 Replace Element Name Character Strings (NITRO Replace Character)
	4.12 Rename Element Names That Exceed 16 Characters (NITRO Rename Over 16 Characters)

	5 Information for Programmers
	5.1 Node Matrices in Maya
	5.2 Node Culling Algorithms
	5.2.1 Algorithm for the “Cull Useless Node” Specification
	5.2.2 Algorithm for the “Merge Useless Node” Specification
	5.2.3 Examples of Node Culling

	5.3 Texture Matrices in Maya
	5.4 Extra Attributes


